NDA Download Manager User Guide

March 2021 – Beta v.0.1.35
Table of Figures ..................................................................................................................... 1

Acronyms............................................................................................................................... 2

NDA Download Manager User Guide ..................................................................................... 2

1. Installation .............................................................................................................................3
   1.1. How to install NDA Download Manager for Windows ....................................................... 5
   1.2. How to install NDA Download Manager for Mac OS X ..................................................... 6
   1.3. How to install NDA Download Manager for Linux .............................................................. 8

2. Updating NDA Download Manager ....................................................................................9

3. Using NDA Download Manager ..........................................................................................11
   3.1. Log in........................................................................................................................................ 11
   3.2. User Interface .......................................................................................................................... 13
   3.3. My Data Packages................................................................................................................... 16
      3.3.1. Data Package Tree .............................................................................................................. 16
      3.3.2. Data Package Table .......................................................................................................... 18
      3.3.2.1. Data Package List ........................................................................................................... 19
      3.3.2.2. Data Package Contents ............................................................................................... 22
   3.4. Shared Data Packages ........................................................................................................... 24
   3.5. Settings .................................................................................................................................... 26
   3.6. Request Help ......................................................................................................................... 26

4. User Download Threshold .....................................................................................................27

Table of Figures

Figure 1: My Dashboard ............................................................................................................ 3
Figure 2: Login ............................................................................................................................ 3
Figure 3: Dashboard Button ....................................................................................................... 4
Figure 4: Data Packages Link ..................................................................................................... 4
Figure 5: Data Packages page .................................................................................................. 4
Figure 8: Windows Installation File .......................................................................................... 5
Figure 9: Windows Installation ................................................................................................. 6
Figure 10: Mac OS X Installation File ....................................................................................... 6
Figure 11: Adding NDA Download Manager to Mac OS X Applications Folder ....................... 7
Figure 12: Adding NDA Download Manager to Mac OS X Desktop ........................................ 7
Figure 13: NDA Download Manager Warning on Mac OS X ................................................... 8
Figure 14: NDA Download Manager AppImage File on Linux ................................................ 8
Figure 15: Setting the NDA Download Manager AppImage File to be Executable from File Browser on Ubuntu Desktop ................................................................. 9
Figure 16: Setting the NDA Download Manager AppImage file to be executable from Linux Terminal .. 9
Figure 17: NDA Download Manager Update Prompt .............................................................. 10
Figure 18: Download Manager Shortcut .................................................................................. 11
Figure 19: Sign in to Authenticate .......................................................................................... 11
Acronyms

AWS  Amazon Web Services
HTTP Hypertext Transfer Protocol
NDA  NIMH Data Archive
NIH  National Institute of Health
NIMH National Institute of Mental Health
OS  Operating System
The NDA Download Manager application is a cross-platform desktop application, available for installation on Windows, Mac OS X, and Linux operating systems. The tool allows users to browse, filter, and download one or all the files included in each data package associated with their account. The tool also provides the capability to add available shared packages to the data packages in their account. The application is built using the electron framework, and requires installation for the best user experience.

1. Installation

For Windows and Mac operating systems, the Download Manager client is available as both a standalone executable that you run to launch the tool, and a setup file that installs the tool. For Linux operating systems, only the standalone executable is provided. The setup file makes modifications to register the application with your operating system, and may require elevated privileges to run. The standalone executable does not make system modifications, and therefore may not require any elevated privileges to run. Having Download Manager installed allows you to follow special links inside the NDA web application that will open the client, and it allows the application to receive automatic updates. Otherwise, there is no difference in functionality between the two distributions.

Links to all available distributions are provided as a part of this User Guide. To obtain the installation file, access the Data Packages dashboard from your NDA User Profile. The Data Packages dashboard can be accessed from the My Dashboard button on the https://nda.nih.gov page, from the login button, or by clicking the dashboard button if already authenticated.

![Figure 1: My Dashboard](image1.png)

![Figure 2: Login](image2.png)

After authentication your NDA User Profile will be loaded. After authentication you can return to the dashboard by clicking the dashboard button from the top menu.
Figure 3: Dashboard Button

From the NDA User Profile, click the Data Packages tab which takes you to the Data Packages page.

Figure 4: Data Packages Link

On the Data Packages page, click the Download Manager button to download the installation file. The application will automatically detect and download the version specific to your operating system. For Linux systems, the standalone executable will be downloaded.

Figure 5: Data Packages page
The application relies on the UserAgent string your browser provides when making HTTP requests. If the application cannot determine which operating system you are using, you may need to manually download the package for your operating system. Please refer to the following table for direct links.

<table>
<thead>
<tr>
<th>File Name</th>
<th>Distribution</th>
<th>Operating System</th>
</tr>
</thead>
<tbody>
<tr>
<td>NDADownloadManager Setup 0.1.35.exe</td>
<td>Setup</td>
<td>Windows</td>
</tr>
<tr>
<td>NDADownloadManager-0.1.35.dmg</td>
<td>Setup</td>
<td>Mac OS X</td>
</tr>
<tr>
<td>NDADownloadManager-0.1.35.AppImage</td>
<td>Standalone</td>
<td>Linux</td>
</tr>
<tr>
<td>NDADownloadManager 0.1.35.exe</td>
<td>Standalone</td>
<td>Windows</td>
</tr>
<tr>
<td>NDADownloadManager-0.1.35-mac.zip</td>
<td>Standalone</td>
<td>Mac OS X</td>
</tr>
</tbody>
</table>

Table 1: Download Manager Distributions

1.1. How to install NDA Download Manager for Windows

The Windows installer will be a .exe extension, and the default download location will be your Downloads directory.

![Windows Installation File](image)

Double-clicking on the installation file or selecting the file and pressing the Enter key will launch the installer.
After installation completes, the download manager tool will open to the login screen, and a shortcut will be added to your desktop.

1.2. How to install NDA Download Manager for Mac OS X

The Mac OS X Installer will have a .dmg file extension, and the default download location will your Downloads directory.

By default, the file will be opened using the Mac DiskImageMounter. To install the application, drag the NDADownloadManager file to the applications folder. Depending on your level of system access and how the Applications directory is configured, this may require elevated or Administrator privileges.
Figure 9: Adding NDA Download Manager to Mac OS X Applications Folder

You may also drag the application to your Desktop and run the file from there.

Figure 10: Adding NDA Download Manager to Mac OS X Desktop
Once the application is added to the Applications directory, or the .app file has been added to the Desktop, you should open the application.

During Alpha testing, versions of the application may be unsigned. If the application is unsigned, a warning will appear indicating the app was downloaded from the Internet. This is normal and you should select Open to open the tool.

Figure 11: NDA Download Manager Warning on Mac OS X

1.3. How to install NDA Download Manager for Linux

The package for Linux will have a .AppImage file extension. Execute the tool to run the application. The AppImage format is compatible across Linux distributions.

Figure 12: NDA Download Manager AppImage File on Linux
Open the location where the AppImage file was downloaded and make the file executable. You can do this by viewing the File’s properties in a file browser.

Figure 13: Setting the NDA Download Manager AppImage File to be Executable from File Browser on Ubuntu Desktop

You may also make the file executable from the terminal.

Figure 14: Setting the NDA Download Manager AppImage file to be executable from Linux Terminal

2. Updating NDA Download Manager

The NDA Download Manager will check for updates to the software automatically if the application has been installed (available on Windows or Mac OS X). If an update is available, the software will prompt the user to download the update. If the client is being run from a standalone executable, the application
won’t notify you of updates. You need to manually download an updated version of the standalone executable in these instances.

The tool does not block user activity while it checks for software updates. After logging in, you might receive a prompt to update. Clicking Yes to update the tool will result in the application closing and any current activity being interrupted. If you do not want the tool to close, choose No and update the tool later.

If you click Yes, the tool will automatically download the update, close and apply the update, and then relaunch the tool. If the tool is running on Linux as an AppImage, you have to download the latest version from the packages dashboard, illustrated previously, and repeat the steps for installation.
3. Using NDA Download Manager

The NDA Download Manager tool can be launched by double-clicking on the desktop shortcut that was created during installation.

![Download Manager Shortcut](image)

*Figure 16: Download Manager Shortcut*

3.1. Log in

All users are required to authenticate and sign in by clicking the Sign In link. This authentication step also retrieves your data packages and any shared data packages available to you.

![Sign in to Authenticate](image)

*Figure 17: Sign in to Authenticate*
After you click the Sign In button, you will experience a slight delay while the application retrieves and verifies access to your data packages. If your account has many packages, this could take more than a minute.

Please wait while Download Manager checks which Data Packages are available and confirms your account has access to them.

If your account has many Data Packages, this could take several minutes.

Figure 18: Loading Application

After the application loads for the first time, you should pick a location with sufficient disk space for storing the files, by clicking the Settings tab and choosing the location. For each data package that is downloaded, the tool will create an individual directory in this location with the Package Id in the name.

Figure 19: Select Download Directory
3.2. User Interface

The interface for the tool is divided into different views representing your available data packages, package contents (folders and files) for each package, shared data packages available to you, and settings. The layout for the user interface is illustrated below. Details for how each of the views work is provided in the following sections.

![User Interface Diagram]

**Figure 20: User Interface**

The user download volume graphic is always displayed. This provides you a visual indicator of data accessed from internet addresses outside of AWS relative to the volume available to you over a 30-day period. Placing the mouse pointer over this graphic will show the actual percentage used, and more detail is available from the Settings interface. See User Download Threshold for more detail.

![Download Volume Graphic]

**Figure 21: Download Volume**

The navigational locations listed above the Main Display window can help you keep track of your location within the tool, indicating the current view (i.e., Shared Data Packages, My Data Packages, etc.), the data package name (if selected), and the folder within the data package (if selected). You can click on any of the navigational locations (breadcrumbs) to navigate to a parent folder within the Package Contents view, or to the Data Package List view.
Throughout the interface, you can click on the orange question mark icon to bring up a Help Center on an individual screen to read targeted help content.

**Figure 23: NDA Help Center**

The settings page allows you to change the location selected for file download that was set-up upon installation of NDA Download Manager. It is important to make sure you have identified the location you wish your files to be downloaded to prior to beginning downloading your files. Information reflecting the files downloaded and the size of the files downloaded will be based on the initial location you have selected for files to be downloaded. You can manually move files within different folders that you have created to make sure these statistics are kept in line if you choose to change folder locations after you begin a download.

In addition, download details can be found on this page. All users have a download limit of 20 Terabytes within a 30-day window. However, only downloads to non-AWS internet addresses will be counted against the limit. For additional details regarding User Download Threshold refer to the User Guide which can be accessed under the Help dropdown from the top menu of the screen.

**FREQUENTLY ASKED QUESTIONS**

- Are there limitations on the amount of data a user can download?
You can logout of NDA Download Manager by clicking on your username and then selecting Log Out.

![Log Out](image)

*Figure 24: Log Out*

Hovering over various fields within the interface will pop up text that provides useful explanations about using and navigating through the tool.

![Hover Text](image)

*Figure 25: Hover Text*

When you interact with each of the views, the Main Display window will update to display the detail for that view.

The tool also includes several options in the File menu that are primarily used for debugging and advanced troubleshooting issues.
Clicking on the Help Menu will bring up this User Guide.

3.3. My Data Packages

The My Data Packages interface is comprised of two elements, the Data Package Tree, and the a table view that you interact with to display a Data Package List and explore Data Package Contents.

3.3.1. Data Package Tree

The Data Package Tree allows you to view all of your data packages, select an individual data packages, and then navigate to the contents of a selected data package using a familiar directory tree interface. Each directory in the data package can be expanded to show sub-directories, and if a directory is
selected in the Data Package Tree, the Package Contents view will update to display all folders and files contained within the selected directory or any of its subdirectories.

Figure 28: Data Package Tree

When a data package is selected from the Data Package Tree there will be a delay while the application retrieves the data packages files and creates a virtual directory tree. For data packages containing a large number of files, this could take several minutes.

If you accidently select the wrong data package you can cancel the process. If you cancel, you need to repeat this process the next time you select the package.

Figure 29: Retrieving Package Files Message and Cancel Button
3.3.2. Data Package Table

The Data Package Table is interactive and allows you to:

- sort contents of the table by selecting a column heading,
- filter the table contents by entering text into the text input fields that appear beneath the column headings,
- change the order of the columns,
- choose which columns to display,
- resize the columns,
- scroll through many results as a series of pages,
- export the contents of the table to an Excel file,
- download packages, folders, or individual files,
- and open the location where folders/files are downloaded.

Figure 30: Table Component - Sort, Filter, Resize and Export
• You can customize the number of rows per page and use the pagination buttons to navigate between pages and to view rows not displayed on the initial screen.

Figure 31: Results per Page and Pagination

3.3.2.1. Data Package List

The Data Package Table will default to displaying a list of the user’s data packages. Both the Data Package Tree and the Data Package Table will list only data packages that are ready for download. Data packages that are still in the process of being created will not appear until the data package creation process is completed. It is important to note that each time you log in and out of the Download Manager application, you will return to this view and previous search filters and detailed download activity from prior sessions will not be displayed. The tool will display the current download progress for each package.

By default, data packages are sorted by creation date, with the most recently created data package appearing first.

Users can download an entire data package directly from the My Data Packages screen by clicking on the Download button. Once the package is downloaded, the Download button will be replaced with a Show button, that will open the download location for that package.

While downloads are in progress, the user interface will be deactivated and a new button Interrupt Downloads will be displayed; information regarding in-progress downloads including percentage
complete, files remaining, and current file being downloaded is found at the bottom of the display window.

If you click Interrupt Downloads, in-progress downloads will stop (partial progress will be saved), and control will be returned to you.

Prior to downloading your files, it is important you review the location you select. This is where your downloaded files will reside. You can review this under the Settings Tab. The interface displays information reflecting the files downloaded and the size of these files based on the initial location you selected. After the download is complete, you can manually move files within different folders you’ve created if you choose.

Users will find that some Download buttons are gray and cannot be clicked on. When you roll over the tool tip, it will let you know that the size of this package is too large to save in the current download location. You must select a different download location, free up disk space, or download specific folders/files within the package.

Figure 32: Download Progress
You can explore the contents of an individual data package by clicking on the package name in either the Data Package Table, or the Data Package Tree. If package files have not been retrieved yet, the tool will retrieve package files.

Figure 33: Gray Download Button

Figure 34: Data Package Name
There will be a delay while the application retrieves the data packages files and creates a virtual directory tree. For data packages with large numbers of files this could take several minutes.

If you accidently select the wrong data package and wish to stop loading the packages files, there is a Cancel button available. If you cancel the operation, you will need to repeat this step the next time you select the package.

Figure 35: Retrieving Package Files Message and Cancel Button

3.3.2.2. Data Package Contents

After you select a data package, the Data Package Table content will update to display the individual folders and files within the package. You may choose individual folders or files for download by selecting the check mark next to the folder or file. The interface also supports selection of a range by selecting a row, holding down the Shift key, and then selecting another row. All rows between the first and second selections will be selected.

The user may download selected folders and files by clicking the Download button that is located to the left of the column headers, above the text fields used for filtering the list of files.
The user may also select the Download button next to an individual row, which will immediately download that folder or file.

Downloaded folders and files will replace the Download button with a Show button, which when selected will open the download location for that folder or file.

Figure 36: Selecting Individual Files for Download

Figure 37: Show Button
You can also filter the list of files displayed in the Package Contents View by entering text into the File Name and Path input fields. As text is entered into these fields, the list of folders and files will update dynamically to show only results that contain the entered text.

The Path column represents the relative directory within the package where the file is located. You can also filter to a specific directory by selecting the directory from the Data Package Tree, or by selecting the folder name from the table. Using the Path column, however, will enable the user to filter for a common subdirectory across multiple parent directories (i.e., fMRI) or a partial match on directory name (i.e., _V1_).

If the Package Contents view contains hundreds of thousands of folders and files, there may be a delay after you enter text into the input field, before the table of results will update, as the tool tries to filter the list as each character is entered.

### 3.4. Shared Data Packages

The Shared Data Packages interface allows the user to view any Shared Data Packages that may be available to them. Shared Data Packages are prepackaged data from featured datasets, which are generally available to users with approved data access for the featured dataset of interest.

The first screen you will see when clicking on the Shared Data Package interface is the Data Repositories screen. A Data Repository is a group of NDA Collections with different access governance. When a user accesses the screen, they will see the specific data repositories to which they have access. To request access, go to the Data Permissions tab in your NDA User Dashboard.
This interface lists available data packages, provides details related to each shared data package, and allows you to add a shared data package to My Data Packages, which will then make a copy of the shared data package within your own account. The newly created data package will be present My Data Packages, where you can access the contents.
3.5. Settings

From the Settings page, you can set the download directory and the tool will default to the host operating system default download location. You can also specify the Download Batch Size, or the number of files to attempt to download at a single time before trying the next set of files.

The Settings page also displays the User Download Threshold, the Download Volume to internet addresses outside of AWS, and the Download Volume Remaining for the next 30 days. For more details, please see User Download Threshold.

A download meter is included a part of the header and depicts the total volume of data downloaded to internet addresses outside of AWS over the total available to you.

![Settings Page](image)

3.6. Request Help

The Request Help screen is found under the Help dropdown on the top menu of the interface. Selecting this screen allows you to create a Help Desk ticket directly from the tool. Can can also send an email to NDAHelp@mail.nih.gov, however using the request help feature directly from the tool will attach the tool’s log file, providing useful data for troubleshooting more efficiently. The NDA Help Desk will reach out to you from the NDA Help Desk email account to assist you. Each NDA Help Center within the interface also provides a Contact Help Desk link that will allow you to begin an email directly to the NDA Help Desk.
4. User Download Threshold

NDA has put into effect a reasonable limit on the rate at which individual users can transfer data out of AWS storage to non-AWS internet addresses.

- All users have a download limit of 20 Terabytes.
- This limit applies to the volume of data an individual user can transfer within a 30-day window.
- Only downloads to non-AWS internet addresses will be counted against the limit.

This limit has been introduced to control infrastructure costs and to share finite resources more fairly for data storage and access across the NDA user base. The allowance of 20 terabytes is considered large enough for most exploratory data analyses, or for prototyping a computational workflow on local infrastructure.

More importantly, data transferred to AWS internet addresses will not count toward this threshold. No download limit is imposed for data transferred this way. NDA provides direct support for accessing and analyzing data using AWS resources through a Computational Credits program.
Users that exceed this 20 Terabyte threshold will receive an email stating that their access to transfer data has been suspended and the date when data transfer will be available again. The email will also include the total volume transferred to non-AWS internet addresses. Data can be transferred again after the prior 30-day download volume falls below 20 Terabytes.

Users that are concerned about their download volumes can email the NDA Help Desk at any time to check their download volume over the past 30 days.

User Download Threshold Examples:

A new user that has never accessed data creates a package whose total volume is 70 Terabytes. The user's account is created with a 20 Terabyte download threshold, and the user has no downloads over the prior 30 days.

Example 1: The user begins downloading the entire package to an internet address associated with a data storage server in their laboratory (outside of AWS) for data exploration and analysis. The user leaves this download to continue and begins working with the files that are initially downloaded.

If data are transferred at a rate of 1 Terabyte per day, the threshold will be reached after 20 days and the data transfer access will be suspended, at which point the download will be interrupted. After waiting another 11 days, the download volume over the prior 30 days will be 19 Terabytes, which is less than their allotted threshold and data transfer access will be restored.

If data are transferred at a higher rate of 10 Terabytes per day, the threshold will be reached after 2 days and the user will need to wait another 29 days before they will be able to transfer additional data.

Example 2: The user transfers data to compute instances or storage that have an AWS internet address. Their download volume will not count toward the download threshold, and access to transfer data will not be suspended. Users can request an AWS account through NDA Computational Credits program.